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Opening Calendar 
You can click onto the calendar icon along the bottom left of your Outlook screen (below 
your folders). 

 

You can also right click onto it to open it in a new window so you have both email and 
calendar open at the same time and can flick between the two.  

 

Note: Your Outlook calendar syncs automatically with your Teams calendar.  

 

Ways to create a meeting: 
There are several ways of creating a meeting in your Outlook calendar.  

 Use the ‘New Meeting’ command in Home tab 

 
 

 Click onto New Teams Meeting command in the Home tab 
 
 
 
 

 Right click into a space in your calendar and choose one of the options. 
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 Double click onto a space in your calendar, then complete the set-up box that opens 
(you may have to click onto Teams Meeting command to convert to a Teams 
meeting)  

 

 

View mode 
Your calendar will be displayed in whichever ‘view’ has been selected - usually a week. 

In the top right corner, you can amend this viewing choice by choosing the drop-down box: 

 

You can choose between day, work week, week, month or schedule view. Schedule view 
displays your calendar horizontally rather than vertically. 
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Home Tab 
The Home tab is where you will find the most commonly used commands. It has groups 
named New, Teams Meeting, Go to, Arrange, Manage calendars. 

 

 

New 

You can use this group to set up a new appointment or new meeting, send a new email, set 
up a new contact or task.  

New appointment 
 

 

 

 

 

 

 

 

If you do not use the ‘invite attendees’ command, this will remain an appointment sitting in 
your calendar to remind you of a task or an appointment you have to attend.  

However, at any time you can easily change an appointment into a meeting. Click onto 
Teams Meeting command or ‘Invite Attendees’ and the set-up box will change to a meeting. 

For help with the commands along the top of he New Appointments ribbon, please see the 
New Meeting section from the following page. 
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New Meeting 
Clicking onto New Meeting brings up the set-up box, similar to Appointments but with a few 
extra commands relevant to meetings, such as ‘Join Teams Meeting’, ‘Meeting Options’ and 
fields in which to invite attendees.  

 

Note: you can also use a ‘quick compose’ approach and simply double-click or right click on 
a free space in your calendar to produce a meeting set-up box as above. 

 Name your meeting by adding a title that gives a good indication of what the meeting is 
about. 

 Invite your attendees using Required field. If you have people who are not mandatory, 
put them into Optional - they will still receive the invite and can choose whether to 
attend. 

 Remember to set your date and time – it will default automatically to current date and 
time, and it is easy to forget to amend this.  

 If you want the meeting to take place more than once, choose ‘Make recurring’ next to 
the date and time boxes. This will open the Appointment Recurrence settings box. 
Default setting is Weekly.  
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Set your meeting to recur daily, weekly, monthly or annually.  

 For Daily, you can further set the recurrence at every 2-3-4-5 (etc) days, or every 
weekday.  

 

 
 
 

 For Weekly, you can select more than one day in the week as long as the time remains 
the same. You can also choose for it to recur every 1-2-3-4-5 (etc) weeks. Weekly is the 
default setting when you first open the ‘Make Recurring’ box 

 
 For Monthly, you either choose the set day of the month on which to hold the meeting 

OR can nominate the third Thursday of every 3 months, for example. 

 

 
 For Yearly, you either set the recurrence for a specific date each year OR choose, for 

example, the first Monday in November each year. Again, you can use Yearly to set your 
recurrence every 1-2-3-4-5… years. 

 

 

 Range of Recurrence: 

Here is where you choose what date to start your range of appointments and for how long 
they happen.  

 

You can choose an ‘End by’ date, to end after a set number of occurrences, or have no end 
date (so to take place indefinitely). 
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Join Teams meeting 

 

To open a meeting or join it, you can click onto the ‘Join Teams Meeting’ command.  

Meeting Options 
As meeting Organiser, you can set some meeting options here, such as who can bypass the 
meeting lobby, who can ‘present’, and when to allow meeting chat. Don’t worry if you 
forget, you can do these at a later point, including during a meeting.  

Note: whoever creates the meeting is the Organiser and is the only one who can make or 
change these settings.  

 

Attendees 

 

You can cancel the invitation here, add attendees, and set your response options.  

 

Response options 
These are tick boxes for the following:  

 Do you want people to tell you they will attend?  
 Do you want your invitees to be able to suggest new times?  
 Do you want your meeting invitation be forwarded to others? Anyone with the link 

could attend.  
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Options 

 

Within this group you can set a reminder and the recurrence of your appointment. You can 
also change how the appointment displays in your calendar.  

Show as: this lets you choose what shows in this time slot on your calendar. Default for an 
appointment is Busy, but you can change this to Free, Working elsewhere, Tentative or Out 
of Office.   

Reminder: the default is 15 minutes, but you can use the dropdown to select either no 
reminder or options between 5 minutes and two weeks. 

Recurrence: brings up the same boxes as the ‘make recurring’ command on pages 6-7. 

 

Tags 

 

Private 
This is where you can set your appointment as Private. Doing this means that nobody else 
can read the title and contents of your appointment, merely see it as ‘busy’ in your 
calendar.  

At any point, even after set-up, you can click into the appointment in the calendar and then 
click on the Private icon to switch between on and off.  

Categorise 
As with emails, you can set categories for your appointments. For example, if you work 
across multiple teams or projects and like to see easily which appointment is with which 
team, use categories to change the display colour in your calendar, as with this example: 

 

Click onto All Categories to set your colour names and set up your categories, as well as 
delete or rename any.  
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Scheduling Assistant 
Scheduling Assistant can help you see who is free for your proposed time/date.  

When you input your invitees names, the system can tell if they are free or busy for your 
meeting, showing a blue bar. To find a convenient free time, just move the bar to fall into a 
gap in everyone’s ‘row’.  

 

 

’Insert’ 

 

This tab is how you attach a file if you want to include documents in your meeting invitation. 

Include group - Attach file 
Attaching files to a meeting invite is the same process as attaching a file to an email.  

Click onto the drop-down arrow and you get the option of ‘Recent Items’, ‘Browse Web 
Locations’ or ‘Browse this PC’.  
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What do these each mean?  

Recent Items are those you have accessed recently. If you click onto one of these, it 
will display the ‘how do you want to attach this file’ options.  

Browse this PC – allows you to attach a document straight from your computer’s 
desktop if you have it saved ‘locally’. This will be a copy of the document, not the live 
document itself.  

Browse web locations – allows you to share documents online. Click onto OneDrive 
and it will open a list of your OneDrive files and folders. 

 

 

 

 

 

 

Click against the document you want to attach, then click ‘Insert’. 

You will be asked how you want to attach: 

 

 

 

 

 

 

What is the difference?  

Attach as a copy takes up space on your email because it attaches a physical copy to 
it. (Current Outlook limit for file size is 20mb.) 

This is a copy, NOT a live version so it’s important to remember that this means each 
recipient gets their ‘own’ copy and, therefore, would return their own copy if changes were 
needed.  

  Share link takes up no space on your email because it simply attaches the link to 
your live document. This way, your recipients can collaborate on it in real time.  

To clarify, sharing as a link displays your attachment with a cloud icon – 

  

 

 



Outlook Calendar user guide V1 Nov 2021 11 

Links 
You could instead put a link into your invitation. It will insert a hyperlink to a webpage or 
document. As with the ‘attach file’ options, you get a choice of your recent items, but also 
can use ‘Insert Link’.  

Click on the drop-down arrow under ‘Link’ and you get a list of your recent documents to 
choose which it then inserts into your email via the hyperlink.  

 

 

 

 

 

 

Remember that you can have a hyperlink leading to somewhere else in your document.  Use 
‘Place in this document’ for this. 

Click onto ‘Insert link’ and your File Explorer folder will open for you to find the file you want 
to link to.  

 

 

 

 

 

 

 

Your link will then appear in your meeting invitation. 
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Review 

 

Review is where you check your spelling and grammar, the accessibility of what you have 
written, or switch to another language. However, in a meeting invitation there may not be 
much to check so please refer to the Outlook Email user guide if you wish to know more 
about Review tools.  

https://inside.barnardos.org.uk/outlook-training-and-guidance 

 

Home tab – Teams Meetings group 
 

 

 

If you want a quick ad-hoc meeting on Teams, you can use the ‘Meet Now’ button. Clicking 
onto ‘Meet now’ opens a Teams meeting screen immediately  - as below - where you can 
name the meeting and set your audio/video controls.  

 

 

Once you click onto ‘Join Now’, you will be in the meeting and can start inviting people by 
using the ‘Invite People’ link box that appears in the middle of your screen. (if you click onto 
the ‘copy meeting link’ it will save to clipboard) . 
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Type a name(s) into the ‘type name’ field and share invite.  

 

Or use the ‘request to join’ option that appears next to a person’s name. This will call them 
straightaway to join your meeting.  

 

 

‘Go To’ group 
 

   

 

This lets you go straight to a particular date in your calendar. Click onto the small arrow in 
the corner to complete the date box options and Outlook will go to that date in your 
calendar. 
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Arrange group 

 

This is your calendar view mode. Choose between day, working week (you can set your 
own), week, months or schedule view, which displays your calendar in a horizontal layout to 
make it easier to see multiple calendars at once to see when everyone is free.  

 

 

Work Week 

As not everyone’s working week is 9-5 Monday to Friday, you can tell Outlook what to 
display when you choose ‘work week ‘ view.  

To do this, click onto the small arrow in the corner of the ‘ Arrange’ group. Your Outlook 
Options box will open (same as if you went in via the File area in top left of Outlook). The 
Calendar section will automatically open, displaying the ‘Work time’ options for you to set.  
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Manage Calendars group 
 

 

 

Here you can add a calendar to your list of ‘other’ calendars or share a calendar.  

To add a calendar, click onto the dropdown arrow and choose from address book, room list 
or the internet. 

 

 

View tab 

 

This tab has groups for setting Current View and Arrangement. 

Current view group 
Click onto the dropdown arrow and choose from Calendar view, Preview, List view or Active 
view. 

 

Calendar view is the one you are used to. Preview shows an entire month. List shows every 
one of your meetings/appointments in a list that you can filter by headings: 
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Arrangement group 

 

This is the same as the Arrange group on the Home tab, except it also has a Time Scale 
command.  

Clicking onto ‘time scale’ lets you change the way your days are divided up in Calendar. 
Current default is 30 minutes, which means your calendar is divided into 30-min segments, 
but you can change this to 60 mins, 15 mins, 10 mins, 6 or 5 mins.  

 

You can also change your time zone within this command.  
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Using the File area for Outlook Calendar 
The File tab is in top left of your Outlook screen and gives you access to a lot of tools to 
customise your Outlook, including Calendar. Click onto Options at bottom left.  

 

 

Choose Calendar from the list. 

 

There are sections for Work time (see page 15 above), Calendar options, Display options, 
Time Zones, Scheduling Assistant, Automatic accept or decline, and Weather. 

Calendar Options 
Useful settings in this section include adding online meeting capabilities to all meetings, 
setting the default duration of new appointments/meetings, shortening appointments by 
having them start later or finish earlier than the full hour, changing the default reminder of 
15 mins, setting allowance for invitees to propose new times. 
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Default duration 

When you create a new meeting, Outlook automatically makes it 30 minutes long. If you 
want another default, choose between 30 mins, 1 hour, 1.5 hours or 2 hours.  

 

Shortening meetings: 
This enables you to adapt the meetings you create so that they are not ‘back-to-back’. For a 
meeting shorter than one hour, you can choose to start a meeting 5/8/10 minutes late or 
end a meeting 5/8/10 minutes early, even when you have booked ‘on the hour’ in your 
calendar.  If the meeting is one hour or longer, the choices are 5/10/15 minutes. This gives 
people time to have a small comfort break if they have a lot of meetings.  

 

Default reminder 
If you are someone that likes a reminder to be half an hour before a meeting, or 5 minutes 
before rather than the default 15 minutes, you can set it here. There is a range of timescales 
from 0 minutes to 30 mins, from 1 hour to 18 hours, or 1-4 days and 1-2 weeks. 

 

Display options 

 

The default maximum number of calendars displayed in vertical view is 5, which means 
when you open 6 or more calendars to look at, Outlook automatically switches to Schedule 
View to make it easier for you to see all calendars. You can change this via the dropdown 
arrow (from 2 up to 30). 

The default minimum number of calendars displayed in vertical view is 1, which means 
when you open one calendar to look at, Outlook will always open it in vertical view unless 
you choose another view. You can change this via the dropdown arrow (from 1 up to 29). 
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Time Zones 

 

At any time, you can change the time zone in Outlook so that it matches your current 
geographic location. Changing the time zone in Outlook is the same as changing it in the 
Windows Control Panel, and the change is reflected in the time displays in all other 
Microsoft Windows-based programs. 

Click the time zone you want to use. When you change time zones, the Windows clock in 
bottom right of your screen changes too. 

 

For more help on Time Zones and how to use a second and third time zone, please see 
Microsoft’s ‘Add, remove or change a time zone’ page. 

https://support.microsoft.com/en-us/office/add-remove-or-change-time-zones-5ab3e10e-
5a6c-46af-ab48-156fedf70c04 

 

Automatic accept or decline 

 

You can set auto-actions on meeting invites. Click onto the Auto Accept/Decline button and 
an options box appears for you to tick to either ‘automatically accept meeting requests and 
remove cancelled meetings’, or ‘auto- decline meeting requests that clash with an existing 
meeting’, or ‘auto-decline recurring meeting requests.  

 


